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Mac mini сконструирован так, чтобы его можно 
было легко подключить и запустить.
Если Вы никогда не пользовались Mac mini или только начинаете 
работать с компьютерами Macintosh, прочтите этот раздел для получения 
инструкций о том, как начать работу. Если Вы являетесь опытным 
пользователем, то Ваших знаний может оказаться вполне достаточно для 
того, что начать работу.

Обязательно изучите информацию главы 2, «Что нужно знать о Mac mini», 
чтобы узнать о деталях Mac mini.

Начало работы 1

Глава 1 Начало работы

Переходник от разъема
DVI к разъему VGA

Адаптер питанияШнур переменного тока
Комплектация может меняться без предварительного объявления



6 Глава 1 Начало работы

Установка Mac mini
Для установки Mac mini выполните указанные ниже действия. Если 
компьютер или адаптер питания упакован в защитную пленку, снимите ее 
перед включением Mac mini.

1 Вставьте шнур переменного тока в адаптер источника питания до конца. 
Подсоедините шнур от адаптера источника питания к компьютеру. 
Подсоедините адаптер питания к заземленной розетке.
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2 Для получения доступа к сети Интернет подсоедините кабель Ethernet 
или телефонный шнур.
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� Подсоедините USB-кабель от клавиатуры и мыши.

Вместе с Mac mini не поставляется ни клавиатура, ни мышь; для 
компьютера можно использовать любую клавиатуру и мышь с 
разъемом USB. Если у клавиатуры есть порт USB, то к этому порту можно 
подсоединить мышь. Если такого порта нет, мышь можно подсоединить к 
порту USB с обратной стороны системного блока.

Примечание: Использование мыши или клавиатуры с разъемом USB от 
любого другого производителя может потребовать установки драйверов 
программного обеспечения. Посетите сайт производителя и скачайте 
драйверы последней версии.
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Для настройки беспроводной клавиатуры Apple или беспроводной мыши 
к Apple на своем компьютере следуйте инструкциям, поставляемым 
вместе с клавиатурой/мышью. 

4 Подсоедините кабель DVI от монитора к порту видеовыхода. Для 
подсоединения монитора VGA используйте переходник компании 
Apple от разъема DVI к разъему VGA, который поставляется вместе 
с компьютером. Для получения более подробной информации по 
подсоединению монитора см. указания в главе 2, «Что нужно знать о Mac 
mini.»

Важно: Ничего не ставьте на Mac mini. Объекты, поставленные на Mac 
mini, могут создать помехи оптическому дисководу или радиосигналу 
AirPort/Bluetooth® в том случае , если установлена вспомогательная плата 
AirPort Extreme или модуль Bluetooth.
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5 Нажмите кнопку включения/выключения электропитания с обратной 
стороны Mac mini.

®
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Завершение работы с Mac mini
После завершения работы с Mac mini есть две возможности.

Перевод Mac mini в спящий режим для экономии 
электроэнергии
Если Mac mini не планируется использовать в течение не более 
нескольких дней, переведите компьютер в спящий режим. Если 
компьютер находится в спящем режиме, экран черный. Вы можете 
быстро “разбудить” компьютер, минуя процесс запуска.

Для быстрого перевода компьютера в спящий режим выполните одно из 
следующих действий:

• Выберите Apple () > Sleep (Спящий режим).

• Нажмите кнопку включения/выключения электропитания с обратной 
стороны системного блока.

• Выберите Apple () > System Preferences (Системные настройки), 
щелкните Energy Saver (Программа экономии электроэнергии) и 
установите таймер спящего режима.

Чтобы “разбудить” компьютер, нажмите любую клавишу клавиатуры. Если 
“разбудить” компьютер из спящего режима, то программы, документы и 
настройки компьютера остаются точно такими же, как перед установкой 
спящего режима.
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Выключение Mac mini
Если Mac mini не планируется использовать в течение периода, 
превышающего несколько дней, выключите его. Выберите Apple () > 
Shut Down (Выключение).

Внимание: перед перемещением Mac mini отключите его. Перемещение 
компьютера при работающем (вращающемся) жестком диске 
может привести к повреждению жесткого диска, потере данных и 
невозможности запуска с жесткого диска.
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В этой главе дается базовая информация, 
которую нужно знать о Mac mini.
Прочтите обзор различных компонентов компьютера и Mac OS X, 
сводную информацию по общим задачам, например настройке 
изображения рабочего стола, подсоединения к принтеру, 
воспроизведению компакт-диска, подсоединению цифровой камеры, 
использованию сети Интернет, получение ответов при необходимости 
помощи и т.д.

Для получения самой последней информации
Так как компания Apple часто выпускает новые версии и пакеты 
обновления системного программного обеспечения, приведенные в этой 
книге изображения могут немного отличаться от того, что Вы видите на 
экране.

На сайте Apple содержатся самые последние новости компании Apple, 
бесплатно загружаемые программы и онлайн-каталоги программного 
и аппаратного обеспечения для Mac mini.

Что нужно знать 
о Mac mini 2
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В разделе Service and Support (Обслуживание и поддержка) на сайте 
www.apple.com (www.apple.com/support) также можно получить 
руководства к многим изделиям компании и техническую поддержку 
по всем изделиям компании Apple.

Основные детали Mac mini

Кнопка
включения/
выключения
электропитания

Защитный
разъем

Индикатор
электропитания

Оптический дисковод
с упрощенной загрузкой

Порт
электропитания

®

Порт 
наушников

Порт Ethernet 
(10/100Base-T)

Порт модема
(дополнительно)

Порт
видеовыхода

Порты USB (2)

Порт
FireWire
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 Оптический дисковод с упрощенной загрузкой 
Компьютер оборудован дисководом Combo, с помощью которого можно 
читать DVD-диски, DVD-фильмы, диски CD-ROM, фотодиски, музыкальные 
компакт-диски, стандартные аудиодиски и носители других типов. С 
помощью этого дисковода также можно записывать музыкальные, 
документальные и другие цифровые файлы на чистые диски CD-R или CD-RW

 Индикатор электропитания 
Если индикатор горит белым цветом, то это означает, что Mac mini включен; 
если индикатор мигает, то это означает, что Mac mini находится в спящем 
режиме

® Кнопка включения/выключения электропитания 
Включение Mac mini или перевод его в спящий режим. Если при 
обнаружении проблемы нажать и удерживать эту кнопку нажатой, 
компьютер выключится.

¯ Порт электропитания 
Для подсоединения шнура питания от адаптера питания.

G Порт Ethernet (10/100Base-T) 
Для подсоединения к сети 10/100Base-T Ethernet, линии DSL или кабельного 
модема.

W Порт модема (в некоторых моделях) 
Для подсоединения стандартной телефонной линии непосредственно к 
внутреннему модему 56K v.92.

£ Порт видеовыхода 
Для подсоединения монитора с разъемом DVI. Также можно подсоединять 
дисплеи с разъемом VGA, используя переходник от разъема DVI к разъему 
VGA, переходник, поставляемый вместе с компьютером.
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d Порты USB 2.0 
Для подсоединения устройств с разъемом USB, например мыши, клавиатуры, 
принтера, сканера, колонок с усилителем, микрофона, концентратора, Zip и 
других дисководов, цифровой камеры, джойстика и т.д.

H Порт FireWire 400 
Для подсоединения высокоскоростных внешних устройств, например iPod, 
камеры iSight, цифровой видеокамеры или внешнего жесткого диска.

f Порт наушников 
Для подсоединения наушников и другого устройства звукового вывода, 
например колонок с усилителем.

¥ Защитный разъем 
Для установки замка и кабеля во избежание кражи (кабель можно 
приобрести отдельно).
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Обучение работе с Mac OS X
Компьютер поставляется вместе с операционной системой Mac OS X, 
которая обладает превосходным интерфейсом пользователя, 
расширенными графическими возможностями и повышенными 
показателями стабильности и производительности.
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Чтобы узнать больше об операционной системе Mac OS X и получивших 
награды программах iLife, посмотрите буклет Welcome to Mac OS X, 
который находится в папке User Guides and Information (Руководства 
пользователя и другая информация) на жестком диске. Также можно 
открыть справочную систему операционной системы Mac OS и 
посмотреть содержащуюся там информацию. Вы найдете большое 
количество информации для новых и опытных пользователей, а также 
людей, переходящих на компьютеры Macintosh с PC.

При возникновении проблем при использовании операционной системы 
Mac OS X смотрите советы по поиску и устранению проблем в конце этой 
книги или выберите раздел Help > Mac Help (Справка > Справка Mac) 
из строки меню в верхней части экрана. Для получения информации о 
совместимости прикладных программ с Mac OS X или получения более 
подробной информации о Mac OS X посетите сайт Apple:  
www.apple.ru/macosx.

Примечание: Для работы с программами под Mac OS 9 эту операционную 
систему необходимо установить (см. «Установка операционной системы 
Mac OS 9» на стр. 47). Операционную систему Mac OS 9 невозможно 
установить как первичную операционную систему на Mac mini, 
и запуск компьютера в этой среде также невозможен. Программы под 
операционную систему Mac OS 9 можно запускать и использовать только 
в классической (Classic) среде Mac OS X.
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Настройка рабочего стола и установка своих 
настроек
Используя системные настройки (System Preferences), можно быстро 
настроить изображение рабочего стола нужным Вам образом. Выберите 
Apple () > System Preferences (Apple () > Системные настройки) из 
строки меню.

Вносите изменения и экспериментируйте со следующими настройками:

•  Desktop & Screen Saver (Рабочий стол и заставка экрана): эта панель 
выбирается для изменения цвета фонового рисунка или изображения 
рабочего стола, либо замены этого изображения на фотографию 
или изображение, которое Вам нравится. Также можно установить 
картинку, привлекающую взгляд и выводимую на экран в то время, 
когда компьютер работает вхолостую.
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• Dock: эта панель выбирается для изменения внешнего вида, 
расположения и поведения панели Dock.

• Appearance (внешний вид): эта панель выбирается для изменения 
цвета кнопок, меню, окон, цвета подсветки и других опций.

Чтобы узнать свой компьютер, попробуйте изменить системные 
настройки. В системных настройках сосредоточено большинство 
настроек Mac mini. Для получения более подробной информации 
откройте справку операционной системы Mac OS и выполните поиск 
по «System Preferences (Системные настройки)» или любой настройке, 
которую Вы хотите изменить.

Подсоединение к принтеру
Драйверы для большинства принтеров включены в состав операционной 
системы Mac OS X. Для работы на Mac mini с принтером следуйте 
поставляемым с принтером инструкциям по установке необходимого 
программного обеспечения и подсоединения принтера к компьютеру.

После подсоединения принтера выберите тип принтера на панели 
Print & Fax (Принтеры и факсы).

Примечание: Если в Mac mini установлена плата AirPort Extreme и 
есть базовая станция AirPort Extreme или AirPort Express, то можно 
подсоединить принтер с разъемом USB к базовой станции (вместо того, 
чтобы подсоединять его к компьютеру).
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Установка принтера:
1 Откройте System Preferences (Системные настройки) и щелкните на 

значке Print & Fax (Принтеры и факсы).

2 Щелкните на кнопке Set Up Printers (Установить принтер).

� Щелкните на кнопке Add (Добавить).

4 Установите тип соединения принтера (чаще всего USB или Rendezvous).

Для добавления принтера с разъемом USB, подсоединенного с базовой 
станции AirPort Extreme или AirPort Express, выберите Rendezvous из 
всплывающего меню. 

5 Выберите или введите данные принтера и щелкните на кнопке Add 
(Добавить).

Примечание: Если соединение с принтером выполняется по сети, то для 
его выбора, возможно, необходимо будет знать сетевое имя или адрес 
принтера. Спросите сетевого администратора.
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Контроль печати
Сразу после отправки документа на принтер можно контролировать, 
останавливать или временно удерживать выполнение заданий на печать.

Для контроля за печатью:
m Щелкните на значке принтера в доке; откроется окно принтера.

Теперь можно видеть задания на печать в очереди и работать с этими 
заданиями. Для получения более подробной информации откройте 
справку операционной системы Mac OS (см. стр. 29) и выполните поиск 
по «printing (печать)».

Воспроизведение компакт-диска и подсоединение 
наушников
Если хотите слушать музыку на Mac mini, вставьте музыкальный компакт-
диск в оптический дисковод. Автоматически запускается музыкальный 
плеер iTunes. Для прослушивания, не мешая окружающим, можете 
подсоединить наушники с миниразъемом к порту наушников Mac mini.

Для прослушивания музыки можно также подсоединить колонки с 
усилителем к порту наушников. Если установлена плата AirPort и имеется 
AirPort Express, то музыку с Mac mini можно транслировать без проводов 
через AirPort Express на подключенную к ней домашнюю стереосистему.
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Более подробно о iTunes:
m Запустите iTunes и выберите Help > iTunes and Music Store Help (Справка > 

Справка по iTunes и музыкальному магазину).

Для получения более подробной информации по оптическому дисководу 
см. «Работа с оптическим дисководом» на странице 39.

Обновление программного обеспечения
Можно подсоединиться к сети Интернет и в автоматическом режиме 
загрузить и установить самые последние бесплатные версии 
программного обеспечения, драйверы и другие разработки компании 
Apple.

При подсоединении к сети Интернет программа обновления 
программного обеспечения (Software Update) проверяет наличие на 
серверах компании Apple пакетов обновления, которые можно было бы 
установить на компьютер. Mac mini можно настроить на периодическую 
проверку сервера компании Apple, загрузку и установку обновленного 
программного обеспечения.

Проверка наличия пакетов обновления программного обеспечения:
1 Выберите Apple () > Software Update (Apple () > Software Update 

(Обновление программного обеспечения)). Открывается окно Software 
Update (Обновление программного обеспечения). При наличии пакетов 
обновления все они появляются в списке.
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2 Установите флажок напротив тех пакетов, которые хотите установить, 
и щелкните на кнопке Install (Установить). Введите имя и пароль 
администратора (имя и пароль, которые Вы ввели при первой настройке 
компьютера).

По завершении обновления программа обновления программного 
обеспечения (Software Update) снова проверяет наличие пакетов 
обновления. Это делается потому, что для установки некоторых пакетов 
обновления необходимо вначале установить их предыдущие версии. 
Для получения более подробной информации выполните поиск по 
«Software Update (Обновление программного обеспечения)» в справке 
операционной системы Mac OS (см. стр. 29).

Подсоединение камеры или другого  
FireWire-устройства
Если есть iPod, камера iSight, цифровая видеокамера FireWire или любое 
другое устройство с разъемом FireWire, то такое устройство можно 
подсоединить к Mac mini. Следуйте инструкциям по установке, которые 
поставляются вместе с устройством. Для получения более подробной 
информации по FireWire см. «FireWire» на странице 37.
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Подсоединение к сети
Если хотите подсоединить Mac mini к сети Ethernet, кабелю или модему 
DSL, либо радосети, см. «Ethernet (10/100Base-T)» на странице 43 и 
«Беспроводной выход в сеть Интернет с помощью AirPort Extreme 
и работа в сети» на странице 37 для получения более подробной 
информации по установке соединения Ethernet или AirPort. Также для 
получения справки можно запустить справку операционной системы 
Mac OS (см. страницу 29) и выполнить поиск по «Ethernet» или «AirPort».

Использование сети Интернет
При первой настройке Mac mini Вы получаете инструкции по тому, как 
установить соединение с сетью Интернет. При необходимости можно 
изменить тип соединения, например на DSL или кабельный модем, 
локальную сеть (Local Area Network, LAN) или сеть AirPort Extreme.
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Перенос файлов на другой компьютер
Есть несколько способов переноса файлов или документов как на Mac 
mini, так и с него.

• Файлы можно легко перенести с помощью помощника при установке 
(Setup Assistant). 

• Файлы можно перенести с помощью сети Интернет, используя 
учетную запись .Mac или другую учетную запись в сети Интернет. Для 
получения более подробной информации посетите www.mac.com.

• Если компьютер подсоединен к сети Ethernet, файлы можно перенести 
на любой другой компьютер в сети. Для получения доступа к любому 
другому серверу или компьютеру откройте окно программы поиска 
Finder и щелкните Network (Сеть). Если же Вы знаете имя или сетевой 
адрес компьютера, выберите Go > Connect to Server (Дальше > 
Соединение с сервером) из строки меню программы поиска Finder.

• Можно создать небольшую сеть Ethernet, подсоединив кабель 
Ethernet от Mac mini к любому другому компьютеру с портом Ethernet. 
Для получения более подробной информации запустите справку 
операционной системы Mac OS и выполните поиск по «Connecting two 
computers (Соединение двух компьютеров)».
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• Также можно подсоединиться к любому другому компьютеру 
Macintosh с помощью кабеля FireWire. После того, как на другом 
компьютере Mac mini появляется в виде диска, можно переносить 
файлы. Для получения информации по использованию FireWire 
для переноса файлов запустите справку операционной системы 
Mac OS (см. страницу 29) и выполните поиск по «FireWire target 
(Перенос с помощью FireWire)».

• Если в системном блоке установлена плата AirPort Extreme, то для 
переноса файлов можно подсоединиться к радиосети AirPort.

Для получения более подробной информации по переносу файлов 
и документов запустите справку операционной системы Mac OS (см. 
страницу 29) и выполните поиск по «transferring files (перенос файлов)».
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Когда программа зависает
В редких случаях программа может зависать. В операционной системе 
Mac OS X зависшую программу можно завершить без перезапуска 
компьютера. Завершение зависшей программы может позволить 
сохранить результаты работы в других открытых программах.

Завершение программы:
1 Нажмите Command (x)-Option-Esc. Появляется диалог Force Quit 

Applications (Завершение программ) с выделенной программой.

2 Щелкните на кнопке Force Quit (Завершить).

Программа закрывается, все другие программы остаются открытыми.

При необходимости можно выйти из классической (Classic) среды, что 
приведет к закрытию всех программ этой среды. Также из этого диалога 
можно перезапустить программу поиска Finder.

Если возникают другие проблемы, см. главу 4, «Поиск и устранение 
проблем» на странице 43.
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Получение ответов на вопросы с помощью справки 
операционной системы Mac OS
Ответы на большинство вопросов по использованию компьютера 
с операционной системой Mac OS X можно найти в справке 
операционной системы Mac OS.
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Использование справки операционной системы Mac OS:
1 Щелкните значок программы поиска Finder в Dock.

2 Выберите Help > Mac Help (Справка > Справка Macintosh) (щелкните 
меню Help (Справка) и выберите Mac Help (Справка Macintosh)).

� Введите вопрос и нажмите кнопку Return на клавиатуре.

4 Дважды щелкните на нужной строчке в списке тем справки.

Использование программ
С Mac mini поставляется ряд прикладных программ, в том числе 
программа iLife, для выполнения таких операций, как работа 
с электронной почтой, поиск по сети Интернет, общение в чатах в режиме 
онлайн, упорядочение музыки и цифровых фотографий, составление 
фильмов и т. д. Для получения более подробной информации по таким 
программам посмотрите буклет Welcome to Mac OS X, который находится 
в папке User Guides and Information (Руководства пользователя и другая 
информация) на жестком диске.
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Mac mini наделен множеством встроенных 
функций, которые можно использовать для 
настройки компьютера нужным Вам образом.
Вот некоторые детали и возможности компьютера:

• Высокоскоростные порты USB 2.0 для подсоединения 
дополнительного оборудования, например принтеров, сканеров, 
джойстиков, клавиатур, цифровых камер и дисководов.

• Порт FireWire для подсоединения высокоскоростного оборудования, 
например iPod, камеры iSight, цифровой видеокамеры или внешнего 
жесткого диска.

• Дополнительный модуль Bluetooth® для беспроволочного 
подсоединения цифровых устройств, например беспроводной 
клавиатуры Apple или беспроводной мыши Apple.

• Коммуникационные технологии, например модем 56K v.92 
(в некоторых моделях), 10/100Base-T Ethernet и дополнительная плата 
AirPort Extreme для работы в беспроводной сети.

Работа с компьютером �
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• Порт наушников для подсоединения наушников, колонок с усилителем 
или другого аудиоборудования.

Чтобы узнать о возможностях Mac mini, начните с изучения информации 
этой главы. Дополнительную информацию можно найти в справке 
операционной системы Mac OS (см. страницу 29) и на сайте Apple 
по адресу www.apple.ru.

Подсоединение монитора или видеоустройства
К Mac mini можно подсоединить монитор с разъемом DVI. Если 
использовать один из описанных ниже переходников, то также можно 
подсоединить монитор с разъемом VGA, а также можно подсоединить 
и другое видеоустройство.

Переходник от разъема DVI к разъему VGA
Используйте переходник от разъема DVI к разъему VGA, который 
поставляется вместе с компьютером для подсоединения монитора 
с разъемом VGA.

Переходник от
разъема DVI
к разъему VGA

Разъем VGA
на кабеле
монитора

Порт
видеовыхода

Порт
видеовыхода

Переходник от
разъема DVI
к видеоразъему

Композитный
видеовыход
и выходные 
порты S-video
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Переходник от разъема DVI к видеоразъему
Также можно подсоединить телевизор, видеомагнитофон или другое 
внешнее видеоустройство с помощью переходника компании Apple от 
разъема DVI к видеоразъему, переходника, который можно приобрести  
официальных дилеров Apple Computer и через розничную сеть компании 
Apple по адресу www.apple.ru/where2buy.

Для получения информации по совместимости со сторонними 
мониторами см. документацию, которая поставляется вместе с дисплеем, 
или свяжитесь с производителем монитора. 
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USB
Mac mini поставляется с двумя USB-портами с обратной стороны 
системного блока, причем эти порты можно использовать для 
подсоединения большого числа разнообразных внешних устройств, 
в том числе клавиатуры, мыши, принтера, сканера, цифровой камеры, 
игровой приставки, джойстика и дисковода на гибких дисках. USB-
разъем облегчает подсоединение периферийных устройств. Чаще 
всего USB-устройство можно как подсоединять, так и отсоединять во 
время работы компьютера. USB-устройство готово к работе сразу после 
подсоединения.

Использование USB-устройств
Для использования USB-устройства просто подсоедините устройство 
к компьютеру. При подсоединении нового устройства компьютер 
автоматически устанавливает новое программное обеспечение.

С обратной стороны системного блока можно подсоединить устройства 
USB 1.1 и высокоскоростные устройства USB 2.0. Скорость передачи 
данных устройств USB 1.1 не повышается при использовании портов USB 
2.0.

порты USB
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Примечание: Компания Apple в состав поставляемого программного 
обеспечения включает средства работы с многими USB-устройствами. 
Если при подсоединении USB-устройства устройство Mac mini не может 
обнаружить соответствующее программное обеспечение, можно 
установить то программное обеспечение, которое поставляется с 
устройством, или посетить сайт производителя устройства и скачать 
программное обеспечение последней версии.

Одновременное использование нескольких  
USB-устройств
Если все USB-порты уже заняты, а надо подсоединить еще одно или 
несколько USB-устройств, можно приобрести USB-концентратор. USB-
концентратор подсоединяется к свободному USB-порту на компьютере 
и обеспечивает наличие дополнительных USB-портов (обычно четыре 
или семь). Большинство USB-концентраторов поставляется с адаптером 
питания, поэтому тоже должно включаться в розетку.

Более подробно о USB
Дополнительную информацию по USB можно получить в справке 
операционной системы Mac OS (см. страницу 29). Выберите Help > 
Mac Help (Справка > Справка Macintosh) и выполните поиск по «USB.» 
Информацию также можно найти в разделе USB на сайте компании Apple 
по адресу www.apple.com/usb.

Информацию по USB-устройствам, соответствующим компьютеру, можно 
найти в справочнике по изделиям Macintosh (Macintosh Products Guide) 
по адресу www.apple.com/guide.
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FireWire
Компьютер оборудован портом FireWire 400, который позволяет легко 
подсоединять и отсоединять внешние высокоскоростные устройства, 
например iPod, камеру iSight, цифровую видеокамеру, принтер, сканер и 
жесткий диск, без перезагрузки компьютера.

С помощью порта FireWire можно сделать следующее:

• Подсоединить iPod и перенести песни и список дел с помощью iSync. 
Использовать iPod в качестве внешнего жесткого диска.

• Подсоединить камеру iSight компании Apple и использовать 
поставляемую программу iChat для проведения видеоконференций 
с помощью высокоскоростного соединения с сетью Интернет.

• Подсоединить цифровую видеокамеру для съемки, переноса 
или редактирования высококачественного видеоизображения  
на компьютере с помощью программы редактирования 
видеоизображений, например iMovie или Final Cut Express.

порт FireWire
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• Подсоединить внешний жесткий диск FireWire и использовать его для 
хранения данных или переноса файлов.

• Запустить компьютер  с внешнего жесткого диска FireWire. 
Подсоедините внешний диск FireWire (с установленной на нем 
соответствующей операционной системой), откройте панель Startup 
Disk (Загрузочный диск) раздела System Preferences (Системные 
настройки) и щелкните на диске FireWire. Перезагрузите компьютер.

Использование FireWire-устройств
Для работы с FireWire-устройством на компьютере просто подсоедините 
устройство к компьютеру. Компания Apple в состав поставляемого 
программного обеспечения включает средства работы с многими 
FireWire-устройствами. Если при подсоединении FireWire-устройства 
устройство Mac mini не может обнаружить соответствующее 
программное обеспечение, можно установить то программное 
обеспечение, которое поставляется с устройством, или посетить 
сайт производителя устройства и скачать программное обеспечение 
последней версии.
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Примечание: FireWire-порт предназначен для обеспечения 
электропитанием FireWire-устройств (мощностью до 8 Вт). Можно 
соединить несколько устройств друг с другом и подсоединить 
устройства к FireWire-порту компьютера. Чаще всего компьютер 
может обеспечивать электропитанием не больше двух устройств. При 
подсоединении более двух устройств на те устройства, которые остаются 
в цепи, электропитание должно подаваться отдельными адаптерами 
источника питания. Подсоединение более двух FireWire-устройств для 
обеспечения электропитания от компьютера может создать проблемы. 
При возникновении проблемы отключите компьютер, отсоедините 
FireWire-устройства и перезагрузите компьютер.

Более подробно о FireWire
Дополнительную информацию по FireWire можно получить в справке 
операционной системы Mac OS (см. страницу 29). Выберите Help > Mac 
Help (Справка > Справка Macintosh) и выполните поиск по «FireWire». 
Информацию также можно найти в разделе FireWire на сайте компании 
Apple по адресу www.apple.com/firewire.
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Работа с оптическим дисководом
С помощью оптического дисковода можно устанавливать или 
использовать программное обеспечение с компакт-дисков и DVD-дисков. 
Можно воспроизводить музыку с аудиодисков и воспроизводить DVD-
фильмы. Также можно записывать музыкальные компакт-диски, которые 
можно воспроизводить на большинстве плееров компакт-дисков, а также 
сохранять документы и другие файлы на дисках CD-R и CD-RW.

Вставка компакт-диска или DVD-диска
Для установки или использования программ с компакт-диска или 
DVD-диска выполните следующие действия:

1 Вставьте диск в оптический дисковод надписью вверх.

2 После появления значка диска на рабочем столе диск готов 
к использованию.

Примечание: Некоторые DVD-диски являются двусторонними, поэтому 
этикетки нет ни на одной из сторон.
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Извлечение диска
Для извлечения диска перетащите значок диска в Trash (Корзину). 
Если извлечь диск не удается, закройте все программы, которые могут 
использовать диск, и попытайтесь снова. Если это не срабатывает, 
перезагрузите компьютер, удерживая кнопку мыши.

Важно: Ничего не ставьте на компьютер. Объекты, поставленные на 
компьютер, могут мешать извлечению диска.

Воспроизведение DVD-дисков
Для воспроизведения DVD-диска вставьте его. Автоматически 
запускается DVD-плеер и начинается воспроизведение диска.



41Глава � Использование компьютера

Запись дисков CD-R и CD-RW
Можно записывать музыку на диски CD-R или CD-RW прямо из 
библиотеки iTunes.

Запись музыки на диск CD-R или CD-RW с помощью iTunes:
1 Щелкните значок iTunes в Dock.

2 Выберите список воспроизведения, который хотите записать.

� Вставьте чистый диск CD-R или CD-RW диск. (Для наилучшей 
совместимости с плеерами компакт-дисков используйте диск CD-R.)

4 В верхней части окна iTunes щелкните Burn CD (Записать компакт-диск).

Запись файлов и папок на диски CD-R и CD-RW с помощью программы 
поиска Finder:

1 Вставьте пустой диск в оптический дисковод.

2 В появляющееся диалоге введите имя диска. На рабочем столе 
появляется значок диска.

� Перетащите файлы и папки на значок диска.

4 Выберите File > Burn Disc (Файл > Записать диск) или выберите диск и 
перетащите его на значок Burn Disc (Записать диск) в Dock.
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Более подробная информация
• Для получения информации о том, как использовать iTunes для записи 

музыкальных файлов на диск CD-R диск, откройте iTunes и выберите 
Help > iTunes and Music Store Help (Справка > Справка по iTunes и 
музыкальному магазину).

• Для получения инструкций по использованию DVD-плеера запустите 
DVD-плеер и выберите Help > DVD Player Help (Справка > Справка по 
DVD-плееру).
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Иногда во время работы с Mac mini могут 
возникнуть проблемы. В этой главе приводятся 
некоторые решения, которые могут помочь при 
возникновении проблем.
В этой главе содержатся решения проблем, которые мешают работе 
с компьютером, например зависания системы или невозможность 
загрузки компьютера. Дополнительную информацию по поиску и 
устранению проблем можно найти в справке операционной системы 
Mac OS (см. страницу 29) или в разделе Support (Поддержка) на сайте 
компании Apple по адресу www.apple.com/support  
и www.apple.ru/support

Если при работе с компьютером возникла проблема, то, как правило, 
есть быстрое и простое ее решение. При возникновении проблемы 
постарайтесь описать те действия, которые Вы сделали перед этим. Это 
поможет сузить область поиска причин возникновения проблемы и тем 
самым быстрее найти нужные ответы. 

Поиск и устранение 
проблем 4
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В том числе необходимо описать:

• Программы, с которыми Вы работали при возникновении проблемы. 
Проблемы, которые возникают только при работе с определенной 
программой, могут указывать на то, что программа несовместима 
с версией операционной системы Mac OS, установленной на 
компьютере.

• Все программное обеспечение, которое было установлено в 
последнее время. Определенные программы устанавливают 
расширения, которые могут быть несовместимы с классической 
(Classic) средой.

• Все новое оборудование (например периферийное), которое было 
подсоединено.

Проблемы, мешающие работать на компьютере
Если компьютер не отвечает или указатель мыши не двигается
• Вначале убедитесь в том, что мышь и клавиатура подсоединены. 

Отсоедините и снова подсоедините разъемы, после чего убедитесь в 
том, что разъемы вставлены до конца.

• Если это не срабатывает, попытайтесь завершить проблемные 
программы. Удерживая нажатыми клавиши Option и Command (x), 
нажмите клавишу Esc. После появления диалога выберите программу 
и щелкните Force Quit (Завершить). Затем сохраните результаты свой 
работы во всех открытых программах и перезагрузите компьютер, 
чтобы проблема гарантированно была устранена.
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• Если программу завершить не удается, нажмите и удерживайте 
нажатой в течение пяти секунд кнопку включения/выключения 
электропитания (®) с обратной стороны системного блока для 
отключения компьютера.

• Если это не срабатывает, отсоедините шнур питания от компьютера. 
Затем снова подсоедините шнур питания и нажмите кнопку 
включения/выключения электропитания (®) на компьютере для его 
включения.

Если при работе с определенной программой часто возникают 
проблемы, узнайте у производителя программы, совместима ли 
программа с данным компьютером.

Для получения поддержки и контактной информации по программному 
обеспечению, которое поставляется с компьютером, посетите  
www.apple.com/guide.

При частом возникновении проблем может понадобиться переустановка 
системного программного обеспечения (см. «Переустановка 
программного обеспечения, поставляемого вместе с компьютером» 
на странице 47).
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Если компьютер зависает во время загрузки или появляется 
мигающий знак вопроса
• Подождите несколько секунд. Если компьютер не загружается, 

отключите компьютер, нажав и удерживая нажатой кнопку включения/
выключения электропитания (®) в течение примерно 5 секунд. Затем 
нажмите клавишу Option и, удерживая ее нажатой, снова нажмите 
кнопку включения/выключения электропитания (®). После запуска 
компьютера щелкните на значке жесткого диска и щелкните на стрелку 
с указателем вправо.

• После запуска компьютера откройте системные настройки (System 
Preferences) и щелкните Startup Disk (Загрузочный диск). Выберите 
локальную папку System операционной системы Mac OS X.

• При частом возникновении проблем может понадобиться 
переустановка системного программного обеспечения (см. 
«Переустановка программного обеспечения, поставляемого вместе 
с компьютером»).

Если компьютер не запускается или не включается
• Убедитесь в том, что шнур питания с одной стороны подсоединен 

к компьютеру, а с другой – вставлен в работающую розетку.

• Нажмите кнопку включения/выключения электропитания (®) и сразу 
нажмите и удерживайте нажатыми клавиши Command (x), Option, 
P и R, пока во второй раз не услышите звук запуска.
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• Если это не срабатывает, отсоедините шнур питания и подождите не 
менее 30 секунд. Снова подсоедините шнур питания и нажмите кнопку 
включения/выключения электропитания (®) для запуска компьютера.

• Если запустить компьютер все еще не удается, см. информацию по 
службе поддержки на странице 56 с данными для связи с компанией 
Apple.

Переустановка программного обеспечения, 
поставляемого вместе с компьютером
Используйте установочные диски программного обеспечения, которые 
поставляются с компьютером, для переустановки как операционной 
системы Mac OS X, так и программ, поставляемых с компьютером, а также 
для установки операционной системы Mac OS 9 (если хотите работать на 
компьютере с программами под Mac OS 9).

Важно: Компания Apple рекомендует перед переустановкой 
программного обеспечения делать резервные копии данных на своем 
жестком диске. Компания Apple не несет ответственности за потерю 
любых данных.
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Установка Mac OS X
Для установки Mac OS X выполните следующие действия:

1 Сделайте, если это возможно, резервные копии важных для Вас файлов.

2 Вставьте установочный диск 1 операционной системы Mac OS X, который 
поставляется вместе с компьютером.

� Дважды щелкните «Install Mac OS X and Bundled Software (Установить 
Mac OS X и стандартное программное обеспечение).»

4 Следуйте появляющимся на экране инструкциям.

5 Выберите диск, в который Вы хотите установить программное 
обеспечение, и продолжайте следовать появляющимся на экране 
инструкциям. Компьютер может перезагрузиться и запросить следующий 
установочный диск операционной системы Mac OS X.

Важно: Так как вариант установки «Erase and Install (Освободить место 
и установить)»  приведет к удалению всех файлов, то необходимо 
сделать резервные копии всех важных для Вас файлов перед установкой 
Mac OS X и других программ.
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Установка программ
Для установки программ, которые поставляются вместе с компьютером, 
выполните указанные ниже действия. На компьютере должна быть уже 
установлена операционная система Mac OS X.

1 Сделайте, если это возможно, резервные копии важных для Вас файлов.

2 Вставьте установочный диск 1 операционной системы Mac OS X, который 
поставляется вместе с компьютером.

� Дважды щелкните «Install Bundled Software Only (Устанавливать только 
стандартное программное обеспечение)».

4 Следуйте появляющимся на экране инструкциям.

5 Выберите диск, на который Вы хотите установить программное 
обеспечение, и продолжайте следовать появляющимся на экране 
инструкциям. Для установки iCal, iChat AV, iSync, iTunes и Safari следуйте 
инструкциям “Installing Mac OS X (Установка Mac OS X)».
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Установка Mac OS 9
На поставляемом Mac mini операционная система Mac OS 9 не 
установлена. Для использования на компьютере программ под Mac OS 
9 необходимо установить  операционную систему Mac OS 9 с помощью 
установочного диска операционной системы Mac OS 9.

Для установки операционной системы Mac OS 9 выполните указанные 
ниже действия:

1 Сделайте, если это возможно, резервные копии важных для Вас файлов.

2 Вставьте установочный диск 1 операционной системы Mac OS 9, который 
поставляется вместе с компьютером.

� Дважды щелкните «Install Mac OS 9 System Support (Установить системные 
средства поддержки операционной системы Mac OS 9)».

4 Следуйте появляющимся на экране инструкциям.

5 Выберите диск, на который Вы хотите установить программное 
обеспечение, и продолжайте следовать появляющимся на экране 
инструкциям.
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Другие проблемы
Проблемы с программами
• При возникновении проблем с программным обеспечением, 

производитель которого отличен от компании Apple, свяжитесь с 
этим производителем. Производители программного обеспечения 
часто предлагают на своих сайтах пакеты обновления к своему 
программному обеспечению. Mac mini можно настроить на 
автоматическую проверку и установку программного обеспечения 
компании Apple на панели Software Update (Обновление 
программного обеспечения) раздела System Preferences (Системные 
настройки). Для получения более подробной информации выберите 
Help > Mac Help (Справка > Справка Macintosh) и выполните поиск по 
«software update (обновление программного обеспечения)».
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Если есть проблемы при работе с радиосвязью AirPort
• Убедитесь в том, что программное обеспечение сконфигурировано 

надлежащим образом в соответствии с инструкциями, которые 
поставляются с картой AirPort Extreme или базовой станцией.

• Убедитесь в том, что Ваш компьютер находится в зоне действия 
антенны с другого компьютера или узла сетевого доступа. Близко 
расположенные электронные устройства или металлические 
конструкции могут создавать помеху радиосвязи и сужать эту зону. 
Изменение положения или поворот компьютера может улучшить 
качество приема.

• Проверьте мощность сигнала AirPort. На значке состояния AirPort в 
строке меню есть четыре положения.

• Убедитесь в том, что на компьютер ничего не поставлено. Объекты, 
поставленные на компьютер, могут создавать помеху сигналу AirPort.

• Могут возникнуть проблемы с производительностью сети, если 
рядом с базовой станцией часто используется микроволновая печь, 
радиотелефон или другой источник помех. Для минимизации помех 
отодвиньте базовую станцию подальше от устройства.

• Для получения более подробной информации по использованию 
AirPort, а также поиску и устранению проблем, выберите Help > Mac 
Help (Справка > Справка Macintosh), затем выберите Library > AirPort 
Help (Библиотека > Справка по AirPort).
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Если есть проблемы с извлечением диска
• Закройте все программы, которые могут использовать диск, и нажмите 

клавишу Media Eject (Извлечение носителя) (C) на клавиатуре Apple. 
На других клавиатурах для извлечения дисков можно использовать 
комбинацию клавиш. Проверьте документацию, поставляемую вместе 
с клавиатурой.

• Если это не срабатывает, откройте окно программы поиска Finder и 
щелкните значок извлечения за значком диска в боковом меню или 
перетащите значок диска с рабочего стола в Trash (Корзина).

• Убедитесь в том, что компьютере ничего не стоит. Объекты, 
поставленные на компьютер, могут мешать извлечению диска.

• Если это не срабатывает, перезагрузите компьютер, удерживая кнопку 
мыши.

Если есть проблемы с подсоединением к сети Интернет
• Убедитесь в том, что телефонная линия или сетевой кабель 

подсоединены и работают надлежащим образом.

• При подсоединении к сети Интернет по телефонной линии убедитесь в 
том, что телефонный шнур подсоединен к порту модема (отмеченного 
значком W), а не к порту Ethernet (отмеченного значком G).

Глава 4 Поиск и устранение проблем



54

Если есть проблемы при работе с компьютером или работе 
с операционной системой Mac OS
• Если в данном руководстве нет ответов на вопросы, посмотрите в 

справке операционной системы Mac OS инструкции и информацию по 
поиску и устранению проблем. Выберите Help > Mac Help (Справка > 
Справка Macintosh).

• Проверьте в разделе Support (Поддержка) на сайте компании Apple по 
адресу www.apple.ru/support наличие новой информации по поиску 
и устранению проблем и новых пакетов обновления программного 
обеспечения.

Если настройки даты и времени часто сбрасываются
• Может понадобиться замена внутреннего элемента питания. Для 

получения более подробной информации см. информацию по службе 
поддержки на странице 56.

 

Глава 4 Поиск и устранение проблем
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Приложение A Спецификации

Для получения подробной информации по Mac 
mini, например размера встроенной памяти, 
емкости жесткого диска, подсоединенных 
устройств и серийного номера изделия, можно 
использовать System Profiler.
Для получения доступа к информации в System Profiler выберите 
из строки меню Apple () > About This Mac (Информация о данном 
компьютере Macintosh) и щелкните More Info (Более подробно).

Спецификации A
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Щелчок на треугольниках в окне приводит к отображению или скрытию 
информации в различных категориях.

Дополнительную информацию можно получить в сети Интернет 
по адресам www.apple.com и www.apple.ru/support.
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Приложение B Правила техники безопасности

Для обеспечения Вашей безопасности и 
безопасности оборудования следуйте правилам  
очистки и использованию компьютера, а также 
указания по более комфортабельной работе.

Очистка Mac mini
При очистке компьютера снаружи и очистке его компонентов следуйте 
данным основным правилам:

• Отключите Mac mini и отсоедините все кабели.

• Для очистки компьютера снаружи используйте влажную ткань, 
не оставляющую ворса. Не допускайте попадания жидкости в любое 
из отверстий. Не разбрызгивайте жидкость прямо на компьютер.

• Не используйте аэрозольные опрыскиватели, растворители 
и абразивные материалы.

Меры 
предосторожности, 
порядок эксплуатации 
и техника безопасности

B
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Перемещение Mac mini
Перед тем, как поднять компьютер или переместить его, обязательно его 
отключить и отсоединить все подсоединенные кабели и шнуры.

Правила техники безопасности при настройке 
компьютера и работе с ним
Для обеспечения собственной безопасности и безопасности 
оборудования всегда принимайте указанные ниже меры 
предосторожности.

Отсоедините разъем питания (держитесь за разъем, а не за шнур) и 
отсоедините телефонный шнур при возникновении любой из описанных 
ниже ситуаций:

• Шнур или разъем питания изношены или повреждены

• В корпус попала жидкость

• Компьютер попал под дождь или побывал в излишне влажной среде

• Компьютер упал или поврежден корпус

• Вы предполагаете, что компьютер нуждается в обслуживании или 
ремонте

• Вы хотите почистить корпус (используйте только рекомендованную 
процедуру, которая была описана ранее)
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Важно: Единственным способом полного отключения электропитания 
является отсоединение шнура питания и телефонных шнуров. Убедитесь 
в том, что один конец шнура питания легко доступен, чтобы его можно 
было при необходимости отсоединить от компьютера.

Внимание: Шнур переменного тока поставляется с 3-контактным 
штепсельным разъемом (штепселем с третьим заземляющим контактом). 
Этот разъем должен вставляться только в заземленную розетку 
переменного тока. Если вставить разъем в розетку не удается из-за того, 
что розетка не заземлена, свяжитесь с квалифицированным электриком 
для замены ее на надлежащим образом заземленную розетку.  

Всегда выполняйте следующие правила:

• Держите компьютер подальше от источников жидкости, например 
емкостей с напитками, раковин, ванн, душевых кабин и т.д.

• Защищайте компьютер от воздействия влажной среды, например, 
дождя, снега и т.д.

• Внимательно прочтите все инструкции по установке перед 
включением компьютера.

• Храните данные инструкции под рукой для обращения к ним не только 
Вас, но и других людей.

• Следуйте всем инструкциям и предупреждениям для системы.
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Важно: Электрическое оборудование при неверном его использовании 
может представлять опасность. Работа с данным или аналогичными 
изделиям всегда должна проходить под контролем взрослых. Не давайте 
детям доступа к внутренности любого электрического изделия и не 
позволяйте им трогать кабели.

Внимание: Ни в коем случае не заталкивайте предметы, какими бы они не 
были, в корпус через отверстия в нем. Это может быть опасно.

Разъемы и порты
Ни в коем случае не вставляйте разъем в порт с силой. Если разъем и 
порт достаточно легко не стыкуются, вероятно, они не соответствуют 
друг другу. Убедитесь в том, что разъем соответствует порту и что разъем 
ориентирован надлежащим образом по отношению к порту.

Адаптер источника питания
Следуйте данным указаниям по использованию адаптера источника 
питания:

• Убедитесь в том, что шнуры питания переменного и постоянного тока 
надлежащим образом подсоединены к адаптеру источника питания.

• Всегда оставляйте место около адаптера источника питания и 
устанавливайте компьютер в том месте, в котором ничего не мешает 
циркуляции воздуха около адаптера источника питания.

 • Единственным способом полного отключения электропитания является 
отсоединение шнура питания, держась за разъем, а не за шнур.
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Важно: Адаптер источника питания для компьютера является 
высоковольтным компонентом и ни в коем случае не должен 
вскрываться, даже если отсоединен. Не давайте детям доступа к 
внутренности любого электрического изделия и не позволяйте 
им трогать кабели. Если адаптер источника питания нуждается в 
обслуживании, см. «Более подробно об обслуживании и поддержке» на 
странице 56.

Внимание: Используйте только тот адаптер источника питания, который 
поставляется с компьютером, и только тот шнур переменного тока, 
который поставляется с адаптером источника питания. Адаптеры и 
шнуры для других электронных устройств могут иметь аналогичный 
вид, но их использование может повлиять на производительность 
компьютера или повредить компьютер. Шнур питания переменным 
током имеет 3-контактный заземляющий штепсельный разъем (штепсель 
с тремя заземляющими контактами), который вставляется только 
в заземленную розетку переменного тока. Если вставить разъем в 
розетку не удается из-за того, что розетка не заземлена, свяжитесь с 
квалифицированным электриком для замены ее на надлежащим образом 
заземленную розетку.
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Защита слуха
Внимание: Если использовать наушники при высоком уровне громкости, 
может возникнуть потеря слуха. Время от времени можно повышать 
уровень громкости, звук может казаться нормальным, но при этом 
может повредить Ваш слух. Установите безопасный уровень громкости 
Mac mini, пока это не случилось. Если Вы слышите звон в ушах, 
уменьшите уровень громкости или перестаньте использовать наушники 
для Mac mini.
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